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PREFACE 

This manual documents the features of OTO 3.0. It is a Macintosh 
program for reading daily growth rings in fish otoliths and calculating age 

in days and daily growth rate. It is based on programs developed at 
Southwest Fisheries Science Center (SWFSC), NOAA, La Jolla, USA, and at 
Institute of Marine Research, Fbdevigen Biological Station, 4800 Arendal, 

determination" and "calculation of daily growth rate" under Appendix, are 
based mainly on Methot (1981). The undersigned wish to address special 
thanks to Dr. Reuben Lasker and Dr. John Hunter for their support of this 

research. 

Norway. The descriptions of "handling the otoliths at reading", "age 

All programming on the Macintosh was done by Tom Lindner, 16357 Hwy 
6 7  

Ramona, California 92065 (61 9) 788-9205 lindner@abac.com. 

Other public domain programs the may very useful with OTO 3.0 include 
NIH Image available with anonymous FTP from zippy.nimh.nih.gov and 

(http://calvin .cc. ndsu. nodak.edu/geo/software/software-list#image) and 
BonyParts from Loo Botsford <Iwbotsford@ucdavis.edu>. The Microsoft 
Excel Macro OPS opens and reads files saved from OTO 3.0. This macro 
compiles data from several files and creates a summary of the data. 

John Butler 
Erlend Moksness 
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INTRODUCTION 

The discovery of daily growth rings in otoliths of fish larvae and fry 
(Pannella, 1971) opened the way to study, in detail, the life history of fish 
larvae and juveniles. 
calculate an individual’s growth rate, if length and weight relationships 
are available. 

By determining the age in days, it is possible to 

Otoliths serve as a permanent record of the life history of an individual 
fish. For most species the formation of daily growth rings starts at the 
end of the yolk sac stage or at the time eyes become pigmented. The exact 
time of formation of the first increment varies among species. After the 
first ring around the nucleus concentric rings are formed that in most 
cases are believed to be daily (Campana and Neilson 1985, Jones 1986). 
The distance between the rings is influenced by food uptake, temperature, 
and other environmental conditions. 
expresses the daily growth of the individual, while the number of rings 
indicates its age in days. More information on otoliths and growth rates 
can be found in Recent De velopments in Fish Oto lith Resea rch (Secor et al 
1995). 

The distance between the rings 

In otoliths of juvenile fish, 
plane at the same time. It is therefore necessary to read different parts 
of the otoliths at separate times, and polish the otoliths with fine sand 
paper between each reading. For various reasons, it is not always easy to 
identify all the daily growth rings without constantly focusing the 
microscope. For otoliths from fish larger than about 40 mm, the field of 
view is not wide enough to observe all the rings at one time on the 
monitor, OTO enables you to move between screens for the full distance of 
the otolith radius. The OTO program is a means to gather information from 
fish larval and juvenile otoliths under such circumstances, and thereby 
estimate age and back-calculate daily growth rates. 

all the rings will not be observed in the same 
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EQUIPMENT 

OTO version 3.0 runs on either an Apple Macintosh@ 68K or PPC computers. 
It is recommended that the System Software version 7.5 or greater be 
used. Microsoft Excel (version 3.5 or later) 
or Delta Graph Pro. 

This program interfaces with 

The following are required: 

1) Apple Macintosh System 7.5 or greater. 

2) Cable with an Apple mini-8 contact and a DB-25 contact at each end. 

3) Two 75 ohm cables with BNC plugs. 

4) Microscope with phototube, polarized filter and 6 . 3 ~  (6.4x), lox,  20x 
(25x), 40x and 1OOx (63x) objectives. The 1OOx objective must be a oil 
objective. 

5) Video coordinate electronic digitizer, H.E.I.., Model 582A. 

6) A high resolution video camera. 

7) A high resolution monitor. 

See also Appendix for specifications and connecting of the 
equipment. 
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STARTING THE PROGRAM 

Install the program disk onto the internal disk and make a backup copy. 
Place a copy of the program in the data folder. The content of the program 
disk is shown in Fig. 2, and an example of the content of a data folder is 
shown in Fig. 3. The otolith reading program is called OTO, and this 
program is used for collecting data from the otoliths and estimating the 
age in days. The calculation of daily growth rate and analysis of data is 
accomplished in Excel. 

I 50 items 368.9 ME in disk 851 MB a4 

Figure 2 Start up screen with logos for the program Oto 3.0 and a 
data folder for Hake. 

7 



Hekg 
1 1  items 420.7 MB in disk 77.9 MB available 

I 

9504 JD 

0 9503-66.7-75.0-9 

0 9503-66.7-80 .O- 1 
0 9503-66.7-80 .O- 1 0 
0 9503-66.7-80 .O- 1 1 
0 9503-66.7-80 .O- 1 2 
0 9503-66.7-80 .O- 1 3 

0 9503-66.7-80.0- 1 4 
0 9503-66.7-80 .O- 1 5 
0 9503-66.7-80.0- 1 6 

8K Oto 3.0 document 
8K Oto 3.0 document 

8K Oto 3.0 document 

8K Oto 3.0 document 

8K Oto 3.0 document 

8K Oto 3.0 document 

8K Oto 3.0 document 

8K Oto 3.0 document 

8K Oto 3.0 document 

Figure 3 Example of the content of the data folder. 

CALIBRATING THE EQUIPMENT 

To calibrate the equipment you need a Stage Micrometer that is placed 
under the microscope. Choose Scale from the Preference Window under 
the Edit pulldown menu (Fig. 4.) 
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Undo Bgz 

Cut 

Paste 
Clear 

C O P Y  
BgH 
BgC 
BgU 

Preferences b Cali brat ion 
Species Distances 

Results Options 
Default Filename 

Magnification Strings 

Figure 4 Choosing the scale. 

This option allows the program to calibrate for both compound and 
dissection microscopes. 
Measurement Scale window (Fig. 5) 

Choosing the Scale option brings up the next 

Measurement Scale 

@ Micrometers Ipm) 

0 Millimeters Imm) 

Figure 5 Measurement scale for Micrometers ( pm) or Millimeters (mm). 
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Version 3.0 of OTO facilitates using the programs on different microscope 
setups. Using the Magnification Strings option in the Preferences 
menu (Fig. 4), the program can be adapted to different microscopes. The 
program allows 5 different magnifications (Fig. 6). The millimeter scale 
can be used with dissecting microscopes to measure distances between 
annuli on otolith sections. 

Magnification Strings 

Power # l  

Pourer #2 

Power #3 

Pourer #4 

Pourer #5 

[Cancel] ((""1 

Figure 6 Magnification window enables OTO to be easily adapted 
to any compound or dissecting microscope. 

To calibrate OTO 3.0 to the objective lenses of a microscope choose 
Calibration from the Preferences menu as shown in Fig. 7. For each 
magnification choose first the left point on the screen, as shown in Fig. 9. 
Move the HE1 bar to the left end of the stage micrometer (Fig 10). 
Thereafter move to the right endpoint, adding the number of pm in the 
distance between left and right endpoints, as shown in Fig. 10. 
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cut %H 
COPY %C 
Paste % U  
Clear 

Preferences b 
.............................................. ..... ..... ..... .............................. 

Scale 

Species Distances T 

Results Options 
Default Filename 

Magnification Strings 

Figure 7 Choosing Calibration for calibrating the program to the 
microscope. 

I 

c ] Interual length in pm [-=I Left endpoint 

Figure 8 Place the cursor at the left end of the micrometer and click on 
Left endpoint. 
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Figure 9 
micrometer, the arrow indicates moving the crosshair to the right 
endpoint. 

Moving the HE1 crosshair to the left end of a stage 

[ I Right endpoint lnterual length in prn 

Figure 10 
The program will automatically calculate the number of pm / unit. 

Enter the number of pm read and click on the Right endpoint. 
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DATA OPTIONS 

OTO version 3.0 allows more flexibility in analyzing data from otoliths 
than previous versions. Data from right and left sagitta can be analyzed 
independently or combined. 

These options can be chosen in the Results options sub menu of the 
Preferences menu. 

t .......................................................................................... 
Cut % H  

Paste % U  
Clear 

Preferences b 

COPY % C  

........................................................................................... 
Scale 
Cali brat ion 
Species Distances 

Default Fiieiame 1 
Magnification Strings 

.......................................................................................... 

Figure 11 Selecting the Results options sub menu in Preferences. 
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Otoliths to Show in the Transects, 
Increments and Results Windows 

0 Show Otolith # l  

0 Show Otolith #2 
@ Show Both Otoliths Aueraged 

Otoliths to Saue in the .results file. 

0 SaUe Otolith 

0 Saue Otolith #2 
S a w  Both Otoliths Aueraged 

[Signature] 0 Output a single file 

@ Output separate files 

Figure 12 The Results options sub-menu. 

Each circle or square in Fig. 12 is a toggle which turns on or off an option. 
This allows the data from one or the other or both otoliths to be viewed in 
the TRANSECTS, INCREMENTS and RESULTS windows. The Output 
separate files option is enabled only if the Save both otoliths 
averaged option is toggled off. 
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I Results File Signature 

Creator 

File Type 
1 I 

[Oefaults] [Cancel] I(""] 

I 6 items 371.1 MB in disk 848.8 MB available 

..... 

test-1 

...... ..... Q ...... 

... ...... 

TTXT .results EXCEL .results 

...... ........ .,"LAY -""-" -*-... 

WPC2 .results1 

fg ---- 
---e 

MSWD .results 

Figure 13 The results file is a TAB delimited TEXT file. The file creator can be 
changed from ttxt (TeachText) to XCEL or other. OT03, WPC2 and MSWD are some 

The Signature default values are ttxt for Creator and TEXT for 
File Type. These parameters will determine how the file appears on the 
desktop. OTO outputs results as Tab delimitated TEXT file. The File Type 
can not be changed. The results file outputs the data in the Results 
window along with the data in the Info window. This is a file that can be 
read into any spreadsheet program. 

Changing the Creator changes the appearance of the file (Fig. 13) on 
the desktop. 
will eliminate a couple of steps in importing the data to EXCEL. 

If creator is XCEL the file appear as an EXCEL text file. This 
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Default Filename In Oto 3.0 the default file name can be changed in the 
Preferences window (Fig. 14). Clicking on each button in this menu 
scrolls through each string in the Info window. 

Default File Name Structure 

Field # 1  Sample number 

Field a2 r Specimennumber 1 
[ 1 

I 

J 

Default File Name Structure 

I Field # l  )I c Species 
I \ c 

I Field #2 [ Specimennumber 
I L 

[Cancel] [OK) 
Figure 14 Default Filename window. 

When saving a new data file, the file name will be determined by the 
settings in the Default Filename preferences. Old data files are saved 
with the initial name. 

Species Distances In OTO version 3.0, data for the distance to the 
edge of the focus and the width of the first increment can be entered 
automatically into the data for otolith. These data can be edited and data 
for new species can be added in the Species Distances window. 
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- 
I - Default Species Distances - 
M... 

Spec i es Focal Distance Ini  t i a l  Increment 

Hake 8 .2  0.5 

Figure 15 Average distance to the edge of the focus and average width of the 
first increment for some species of fish. 

Double clicking on a species enables editing the data for that species 
(Figure 16). 
the average of many observations. 

Data for Focal Distance and Initial Increment size should be 
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Species 

Focal Distance 16.8 I 
Initial Increment 0.8 

1 Cancel 

Figure 16 Editing the distance to the edge of the focus and the 
initial increment size for sardine. 

Data for a species of fish can be deleted by holding down the option (alt) 
key while double clicking on a species. After double clicking on a species 
a window appears which allows the option of deleting that species or 
canceling the process. 

I I 
I 

Delete Sardine 

Figure 17 Deletion window. Clicking on OK will remove the data for 
sardine. 

Holding down the Command key (d) while double clicking on a species will 
enable the addition of data on another species. 
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Initial Default Distance Settings II 
Species m 
Focal Distance 0.0 

[Cancel) (0")) 
Initial Increment 0.0 1 

Figure 18 Data entry window for entering distance to edge of focus and 
initial increment size for a new species. 

OPENING OF NEW DATA FILE 

For opening of a new data file, choose hew from h e  File menu (Fig. 19). 
This gives a new window (Fig. 20) with default values. Change the 
necessary parameters. To move from one parameter to another, use the 
tab key or the cursor. 
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......................................... 

......................................... 

Figure 19 Choosing New from the File menu. 

.............................................................................. ...................................................................................... 
Untitled * 

Current specimen: 

Sample 

Date 

Species 

66.7 75.0 

0311 8/95 

Hake 

Serial number 

Length 

Wet weight 

Dry weight 

Camment: 

Mounted by BN. Read by RN. Polished. 

Figure 20 Window with default values after choosing New. 
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Default values change each time a file is saved. This reduces the amount 
of data entry when processing several files from the same Experiment. 
This file will be saved as 66.7 75.0-1 using the optional default file name 
of sample and specimen number (Fig 14). 

Fill in the window Current specimen as follows: 

Experiment: 
Sample: 
Date: Month/day/year (Excel format). 
SDecles. Name of species. 
Serial number: Numbering of examined individual. Start on 1 for each 
new Experiment. 
Lenath (mm); Standard length in mm 

The individual's wet weight in mg 
Drv weiaht (ma): The individual's dry weight in mg 
C o r n m u  Name of person who mounted the otoliths and who read them, 
whether 1 or 2 otoliths were mounted. 
at mounting or reading and readability of the otoliths can also be stored 
here. These data can be reviewed at any time by choosing Info in the 
Windows menu. (Fig. 21). 

Cruise or experiment no. and/or name 
Station no. of cruise or experimental no. in laboratory. 

Information about special problems 

Remember to use Tab for switching between the different parameters 
or click between data windows. 

Transect Quality 
Increment widths 
Results 

Data Entry I 
Figure 21 Choosing Info from Windows menu. 
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OPENING OF EXISTING DATA FILE 

To open existing data file, chose OPEN from the FILE menu (Fig. 22), and 
the desired data file is shown on the screen (Fig. 23). Addition of new 
data is discussed the Reading Otoliths section below. In order to 
prevent data from being recorded in the wrong file, only one file may be 
open at a time. 

Remember: The data from both otoliths of the same individual must be 
stored in the Same d& file. 

Figure 22 Choosing Open to fetch existing data file. 

2 2  



9503 JD I m Z F P  510-Q 

[Ejar?ft) 
9503-66.7-75.0-2 [Oesktop) 

;:;:,. ... Im 9503-66.7-75.0-3 --- 

9503-66.7-75.0-6 
9503-66.7-75.0-7 

Figure 23 The contents of a folder with existing data files. 

READING THE OTOLITHS 

By convention the otolith is read from left to right (Fig. 24). The first 
measurement should be a measurement of the radius from the center of the 
focus to the otolith margin. For reading of otoliths choose Enter Data 
and the window Session control appears (see Fig. 26). A sketch of an 
otolith is shown in Fig. 24. Focus is the core and the original otolith. 
Edge of Focus is the first observed ring (daily increment) and Margin is 
the otolith's outer edge. Reading direction is either from the center, 
Start at Focus, or from the outer edge, Start at Margin. The readable 
parts of the otolith is shown in Fig. 24. On the video-screen the 
otolith should always be read from left to right. 

The cursor on the video monitor are controlled by the scroll bar in the 
bottom of the "Session control" window (Fig. 26). 
(mouse) into the scroll bar, it changes from an arrow to a box with the 
letter HEI. 
simultaneously clicking the mouse, makes the cursor on the video monitor 
to move to left. Placing the HEl-box in the right part of the scroll bar and 
clicking the mouse makes the cursor to move to right on the video monitor. 

By moving the arrow 

Placing the HEl-box in the left part of the scroll bar and 
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I I  I /  Reading direct  i on 

Edge o f  Focus 

FOCUS 

Figure 24 Sketch of otolith showing the most important parts. 
be taken along a consistent path to an identifiable land mark on the otolith. 

Data transects 

I I  File Edit 

Info 
Raw Data 

Increment widths 
Current spec Transect Quality 

Sample 
Date 

Figure 25 Choosing Data entry from the Windows menu 

2 4  



Procedure: 

The general procedure to read otoliths is to first measure the radius from 
the center of the focus to the edge of posterior margin. Large increments 
are read with the lowest magnification before proceeding to higher 
magnification. Polishing the otolith and remounting large otoliths on the 
opposite side may be necessary to view all increments. 
increments near the focus or outer margin are read last. 

Often the fine 

The first reading of the otolith of a new specimen should be a 
measurement of the counting path. 
measure from the center of the focus to the outer margin and end the 
measurement with Complete in step 6. 

Using steps 1 to 3 and 6 below, 

1. Choose Data entry from the Windows menu (Fig. 25). 

2. Check that otolith no., magnification and starting position are 
correctly given (Fig. 26 and 27). 

3. Place the cursor on the video screen on the focus (or the Margin) 
and start reading be pressing Start (Fig. 26). 

4. Move the cursor on the video screen by the scroll bar in the 
bottom of the window to the first readable increment. If the 
magnification is smaller than 40 x, the edge of the Focus can hardly be 
seen, therefore choose "Unreadable". This means that no increments 
are counted and the first observed increment is not the Edge of Focus 
(first real increment). Using magnifications of 40x , 63x or 1OOx the 
first real increment may be seen. When it is apparent that you are able 
to read the first real increment Edge of focus in Session Control 
window is chosen. (Fig. 28). In addition you have to choose 
"Unreadable" because the "Edge of focus" button is only used as 
information to the reader where he or she observed the first increment 
and are not later used in calculation of age in days and daily increments. 
In situations where the reader can not see the first increments (esp. the 
otoliths is broken) the reader has to put in an expected first increments 
(distance - 6.0 pm from the nucleus in autumn spawned herring) with a 
couple of following increments (usually 0.7 to 0.8 pm). The calculations 
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of age in days and daily increments will always be preformed from the 
first observed increment. 

5. For further reading of the otolith radius, indicate the number of 
increments that are observed (it is recommended to read less than 5 
increments at a time), together with the quality of this reading, in the 
bottom left corner of the window (Fig. 29). 
"Readable". 
choose "Unreadable" (Fig. 29). 

Press thereafter 
If no increments are observed in a part of the otolith, 

6. If the counting path is greater than the width of the monitor, move 
the otolith to the left using the stage controls of the microscope. 
Carefully observe the new position of the last increment and move the 
crosshair to the new position. 
Control and continue counting (Fig. 30). This procedure can be repeated 
until the whole otolith is counted. 

Enter Stage Moved in the Session 

8. After reading the otolith, indicate the quality of the whole reading 
(Quality of transect) and the reading is completed by pressing either 
Complete, Incomplete or Discard (Fig. 29 and 30). 

9. You are now ready for a new reading, whether it is another 
magnification, the other otolith, or the same otolith at the same 
magnification. Start again from point 2. 
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1 I Start at 1 I [ 6.4H Magnification ] 

I 

I I Quality of transect CO ... 9) 1019101 [ Default Transect ] 1 

I r  Start 

Number o f  growth increments ml 
Quality o f  increments ( 0  ... 9) mi 

1 

Figure 26 
bottom of the window) to move the video cursor and the button to start 
reading. 

Clicking on the arrow on the left or right ends of the digitizer 
control bar moves the cursor one pixel to the left or right (Fig. 26). 
Clicking on the bar to the left or right of the slider moves the cursor ten 
pixels to the left or right. Moving the slider along the bar moves the 
cursor on the monitor to corresponding position. 

Session control window, showing the Digitizer control bar (at the 
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I Otolith # 2 

Quality o f  increments ( 0  ... 9) 1-1 

[ 25 H magnif icat ion 

I Readable I 

Start a t  Margin 

Choose otol i th 

Choose magnification 

Start reading f rom Focus 
or  f rom margin 

Figure 27 
magnification and starting point. 

Boxes indicating correct otolith number, 

E-J - Session 1:l 
I I 

I ( I f  aIif $3 $ 1  1 [ fL--EI( +4aqcai#ic:4f ian ] I Sf 1H.f 4 4  41s I 

I Complete 1 Incomplete 1 I D i s ca r d  I 
Quality o f  transect ( 0  ... 9) 1019101 

Coordinate ## 1 
7.8 pm t o ta l  distance f rom focus 
7.8 p m  f rom last  cursor position 

I 1 I Number o f  g rowth  increments 

[ Stage moued 1 
[ Edge o f  focus 4-l 
I I trnr t 

[ U nrea da bl e I 

Figure 28 
focus. 

Example of session control window after moving 7.8 pm from 
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........................... Session 1:l ~ 

I I Quali ty o f  transect 10 ... 9) 1019101 I Default Transect ] 

Complete I [ Incomplete I I D i sca r d  
I I  I 

Coordinate # 1 
0.0 pm to ta l  distance f rom focus 1 0.0 pm f rom last cursor position 

I I  u I I Number o f  g rowth  increments 

I 1 Quality o f  increments ( 0  ... 9) 1-1 
I L  I 

[ Stage moued 
I 

I I 
[ Start I 
I Unreadable 1 

Edge o f  focus 

I Readable 1 
\ I 

Figure 29 Example from the session control window showing how the increment 
number and quality are edited. 

Quality o f  transect I0...91 -1 [ Default Transect ] 
1 ComDle t e 1 I lncomdete  1 I Discard 1 

I I 
I 1 1  1 I Coordinate ## 14 I I [ Stagemoved ] I  

I Edge o f  focus 1 
I S m " t  I 

34.6 pm to ta l  distance f rom focus 
-80.6 pm f rom last  cursor position 

I 1 1 Number o f  g rowth  increments 11101 I I r  Unreadable 1 1  
I I Quality o f  increments ( 0  ... 9) -1 I 1 [ Readable 

Figure 30 Moving the counting position to the left and entering Stage Moved. 
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( Readable ] Can see increments 
% 

I Unreadable 0 Cannot see increments 

Quality o f  transect ( 0  ..A) 1 ~ ~ 1  Quality o f  transect 
(0-91, O=bad 

I Complete 1 Transect measure the o to l i th  radius 
% 

I Incomplete I Transect does not measure radius 

1 Discard I 

Figure 31 
window. 

Explanation of some of the control buttons in the session control 

The Data Entry session control window (Fig. 29) contains a button for 
Default Transect. This button is enabled only when no measurement of 
the focus has been made. The Default Transect enters a distance to the 
focus and width of the first increment. 
accurate ages when increments cannot be read near the focus. 

These values will produce more 

SAVING DATA 

When you have finished the first reading of an otolith and want to save it 
for the first time, choose Save as from the File menu (Fig. 32). A 
window appears as shown in Fig. 33 with a default name given. Usually 
this file name is accepted, but may be modified as desired. 

After later readings choose Save from the File menu, since the file has 
already been established. If you leave the program by Close or Quit (Figs. 
34 and 35) and data are not saved, a window (Fig. 36) will appear asking if 
the changes made are to be saved. If you have made changes and want to 
save them, click Yes. 
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Edit Ulindows 

... ... . . . . . . . . . .. . . . . . . . . . . . . . . .. . .. . . . .. 
Close % W  d Sizilre :ae:5 1 

Qua %%IT%! I y o  

Figure 32 Choosing Save as.. From the File window. 

Data OTO 

[ Driue J 

Saue raw data as 
I Herring- 104 I I Cancel 1 

Figure 33 Window after choosing Save as.  A default name is given, but the 
user can choose any name he/she wishes. 
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Saue % S p  
Saue as... I c ......................................... 

Figure 34 Choosing Close from the File menu. 

......................................... 

Figure 

y ......................................... 

35 Choosing Quit from the File menu. 
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C o m m O  . . . . .  
. .. . . 

Mounted by EN. Read by RN. Collected with MDCNESS in 
net 5 o f  6. 

Saue changes t o  
9504-57.8-53.1 -ml 

EHperimen 

Sample 

[Cancel] [Oon't] ([-j Date 

Species 

Figure 36 Window after choosing Quit or Close. 
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EVALUATION OF DATA 

For evaluation of the readings and the quality of each reading in relation to 
each other choose Raw Data and Transect from the Windows menu (Fig. 
37). 

Current speci Transect Quality-’ 
Increment width! 
Results 

Sample 
Date 

Figure 37 Choosing Raw Data from the Windows 
menu to look at the raw data. 

Choosing Raw Data gives a window (Fig. 38) with general information 
about the examined otolith/ otoliths (2 otoliths from the same 
individual). 
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rn 9504-57.8-53.1 -ml  

Transect Otol i th Direction Magnification Data Points Status Qual i ty  

1 # l  FOCUS-- > 25x 3 rn 9 

4 5 
3 + 1  Marg i n- > 4ox 14 0 5 

4 *2 FOCUS-- > 25X 3 9 
5 92 FOCUS-- 40x 23 4 7 
6 #2 Margin-, 4ox 18 4 7 

Figure 38 Data collected of each transect can be edited using the Raw-data 
window. 

Figure 38 shows a summary of the data from the individual "9504-57.8- 
53.1-ml", with a total of 6 transects, 3 transects on otolith no. 1, and 3 
on otolith no. 2. Each line in this window consists of two clickable 
buttons. Clicking on the left side permits editing of each reading of the 
number of increments and quality of reading. Clicking on the right side 
permits editing of magnification, direction and transect weighting. The 
individual distances cannot be edited. 

The window (Fig. 38) is interpreted as follows: 

#1 Otolith no. 1 

# 2 Otolith no. 2 

FOCUS --> Reading direction from Focus 

Margin --> Reading direction from Margin (Outer edge) 
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6 . 4 ~  etc. Magnification on the microscope while reading 

3 measurements Number of measurements (observations) made 

Complete radius measured 

0 Incomplete radius measured 

(9) etc. Quality of reading 

Double clicking a reading (Fig. 38) gives detailed information about each 
reading. 

- 
SpJ I . . ~  Transect 2 

0 i s tance I ncrements Qua I i t y  

6 .9  
11.1 

14.3 

17.6 

20.9 

24.7 
28.5 

32.7 

36.8 

41.9 

focal edge 
4 

4 

5 
5 

5 

5 

5 
5 

5 

Figure 39 Details of data taken in Transect 2. 

The data for each transect (Fig. 39) follows the following format: 

Distance 

Increments number of increments observed 

distance from Focus (center) or Margin. 
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Quality given quality of reading 

The reading can also be evaluated graphically by choosing Transects 
Quality from the File menu (Fig. 40). 
provided as distance (pm) from Focus (center) (Fig. 41). The height of 
the column indicates the quality of the readings, where low height 
indicates low quality. The + under the line indicates the distance for each 
reading. The order of the transects follows the order of the readings, and 
these can be seen by choosing Raw data (Fig. 36). It may be necessary to 
scroll the picture to see the whole graphical presentation. 

The position for each increment is 

To print the Transect, copy and paste into a spreadsheet, 
graphics or word processing program. 

1-1 Results I- 

Figure 40 To view the raw data choose Transect 
Quality from the Windows menu. 
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Qual i ty 

g1 

Qual i ty 

0 100 

Figure 41 
each graph indicate the transect number. The height of each bar is a measure of the 
quality of the reading. 

Graphical presentation of quality of the raw data. The number in front of 

The width of the increments along the transects can be viewed in the 
Increments widths window. Choose Increments widths in the Windows menu 
(Fig. 40). 
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"7 

Figure 42 The Increments window displays the width of each increment. 

In both the Transect and Increment windows, a measurement line can be 
obtained by holding down the button on the mouse. The line projects back to the 
Y axis and can be moved up and down with the mouse. 

In both the Transect and Increment windows, the scale can be expanded to 
see more detail. To expand the Y axis, hold down the Option (alt) key and click 
on the graph. To expand the X axis hold down the Command (d) key and click on 
the graph. To shrink the Y axis, hold down Shift and Option and click, to shrink 
the X axis hold down Shift and Command. 
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EDITING THE DATA 

To edit the raw data choose Raw data from the Windows menu (Fig. 40). 
To change any reading in a transect double click on the left side of any 
line (Fig. 41). This brings up a window for that transect. 

nsect 3 ___I___ 

nts  Status Qual i t y  

rn 

Figure 43 By double clicking on one of the lines in Fig. 37, this window 
appears, giving detailed information about each reading. 

The number of Increments and associated Quality can be edited by 
double clicking on either data point. 
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Transect Data Parameters 

Number o f  increments 1012101 I 
Quality o f  increments -1 I 
I Readable 1 

Figure 44 Editing the number or quality of a data point. A measurement 
can be changed from Readable to Unreadable in this window. 

The Transect Parameters can also be changed by clicking on the right 
portion of any line in Fig. 32. 

41 



9504-57.8-53.1 -ml 
~ _______. 

P 

~~~~ ~ ~~ 

Transect Otol i th Direction Magnification Data Points Status Qual i ty  

1 * 1  FOCUS--> 25X 3 9 
2 
3 

* l  FOCUS-- > 
+ l  Marg i n- > 

40x 

40x 

24 
14 

4 *2 FOCUS-- > 25X 3 

5 92 FOCUS-- 40x 23 

6 +2 Marg i n-> 40x 18 

4 5 

rn 9 
0 7 
4 7 

Figure 45 Raw Data window. Clicking on the right side of any line opens a 
window that edits Transect Parameters. 

This brings up a new window with the Quality of the Transect, 
Direction, Magnification, Otolith and the measurement parameters 
Complete and Incomplete (Fig. 45). 
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Transect Parameters 

Quality o f  transect ml 
I Complete ] [ Start at FOCUS ] 

I 

I 40H I I Otolith # l  1 I 

c Cancel I [OK] 

Figure 46 Window for editing Transect parameters 

Changing the Quality of the transect will give the observations more or 
less weighting in the Results. Changing Incomplete to Complete will 
make the length of the transect a measurement of the entire counting 
path. The length of the transect will then be averaged with other 
measurements of the otolith radius. The measurements will also be 
scaled to the average otolith radius. 
at Margin will change how the measurements along the transect are 
displayed in the Transect and Increments windows and how the data 
are averaged in the Results window. Changing the Magnification from 
40X to any other magnification will convert the distances measured from 
one calibration factor to another. Clicking on the Otolith button will 
change the data from Otolith 1 to Otolith 2. 

Changing Start at Focus to Start 

These improvements to OTO greatly improve the flexibility of the 
program, but they must be used with caution! 
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ESTIMATING AGE IN DAYS 

For estimating age in days choose Results from the Windows menu (Fig. 
47). An automatic calculation of age in days is done, based on the read 
daily increments, as shown in the window Results (Fig. 48). To produce 
all data scroll the window by placing the arrow as shown in Figure 48 and 
press the mouse. The last data pair are the number of increments and 
radius of the otolith. To this calculated age (number of increments) must 
be added a certain amount of days that corresponds to the number of days 
between hatching and the first visable increment. This number will vary 
from species to species. 
about 10 days. Therefore, the individual’s real age is determined by 
adding calculated age (last number in the increment column) and 10 days. 

In Norwegian spring spawning herring this is 

Sessit 
1 .................................. :.1 ..... I 

Figure 47 Choosing Results from the Windows menu. 
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I Age <days> Radius (pm> Quality (04) I 
20.3 0.0 
24.7 5 . 0  

2 

3 
4 

5 

6 

7 
8 
9 

10 
1 1  

12 

29.8 

35.7 

41.3 

47.8 

53.9 
60 .  1 

67.4 

76.4 

86.2 
96.6 

110.1 

6 . 2  

6 .8  
6 . 3  

6 .7  

6 .8  
6 .7  
6 . 5  

6 . 5  
6 . 5  

6.5 

6 . 5  

Figure 48 The window Results. By scrolling down as indicated in the 
figure, the age of the larvae at sampling will show up. 

CALCULATING DAILY GROWTH RATE 

For calculating daily growth in length and weight, use the program OTO 
together with EXCEL. When in OTO, and with the window Results 
showing on the screen, the data can be copied by using Copy Results 
from the Edit menu (Fig. 49). Switch to the EXCEL program and mark 
space for the results on the sheet, then use the Paste function to 
transfer the data. The data are now transferred to the EXCEL spreadsheet 
and ready for analysis. 

The other option is to use the Excel macro “OPS” to read the results 
stored in the OTO 3.0 results files. This macro opens the files and pastes 
the data into an Excel workbook. In the Buttons worksheet, click on the 
Directory button to locate the files to be summarized. Do not open the 
first file! Click on Cancel and the file names will appear. Click on the 
Summarize button and the results of all files will be copied and pasted 
into the Summary worksheet. 
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Q Windows 

Results ....... .. . . ...... . . .. ....... .. .... . . . ............................ 

3 35.7 
4 41.3 

5 47.8 

Figure 49 Choosing Copy Results from the Edit menu. 

PRINTING 

The easiest way to get a print is by simultaneously pressing the three 
buttons shown in Figure 50. This corresponds to screen dump to printer. 
Remember that the printer must be connected. The other way to get a 
printout is to copy and paste the data to another program, or by using 
Copy function in the Edit menu (see below, and Figs. 50, 51, 52 and 53.) 
and transfer the text/data/graphics to the clipboard for later printing via 
word processing or draw program. 

Dv-fu nction DV from WindoB Shown in F i a w  
Copy Results Results 49 

Copy Transect Transect 53 
Copy Info Info 54 

Copy Graph Condensed Transects 51 
Copy Sessions Raw-data 52 
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Figure 50 The three keys on the keyboard for a screen dump to printer. 

Figure 51 Choosing Copy Graph from the Edit menu. 

..................................................................... 

. Preferences P I C  

Figure 52 Choosing Copy Sessions from the Edit menu. 
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............................. ........................................ 

Increments Quality I [  - 

unreadable I Qualit 
I ,-  

I I 
focal edge 

Figure 53 Choosing Copy Transect from the Edit menu. 

....................................................... 

Figure 54 Choosing Copy Info from the Edit menu. 
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APPENDIX 

Storina of samples .larvae. oto liths etc.1 

It is recommended to store samples of fish larvae and juveniles either by 
freezing or in alcohol for later mounting of the otoliths (Sagittae). If the 
samples are stored in alcohol, the alcohols should be changed ones after 
about 24 hours. The alcohol should be buffered as suggested below: 

Buffer for ethanol: 

Tris (hydroxymethyl) aminomethane, 99.0-99.5%, saturated solution, 40%. 
This saturated solution is mixed with 80% ethanol in the proportion 6.6 
m l / l .  

Mounting of otoliths 

The length of the larvae/juveniles are measured to the closest 1.0 mm 
standard length. The largest otolith, sagittae, is removed and mounted on 
a glass plate as shown in Fig. 55. For mounting use Cytoseal, Pro-Texx or 
clear nail polish (Sally Hansen 8: Hard as Nail with nylon). The dry weight 
of each individual is measured to the nearest f 1 pg, after having been 
dried at 60°C for 24 hours. 
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t 
G1 ass-sl i de 

Exp.* 
Sample * 
Specimen * 

1 2 

Figure 55 Sketch of mounted otolith. Otolith number 1 is always to the left 
on the glass slide. 

Treatment of otoliths for reading 

Otoliths of e.g. herring juveniles over 30 mm in length may be too thick to 
allow the passage of enough light, so that the reader (operator) will be 
unable to see all the growth rings. This necessitates removing of 
material from the otoliths to expose growth rings. This can be done 
either by using acid (5-10% HCL) or fine sand paper (0.3 or 30 pm). When 
using acid, the parts of the otoliths you don't want to treat can be masked 
with lens oil or a mounting medium. 
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Aae dete rmination 

The age is calculated according to the formula Methot (1981): 
n 
c J l 2 - 1 -  

i=O G(rJ 

G(rJ = average increment size between ri-1 and ri 

ro = Otolith radius to first increment (Edge of focus) (6.5 - 8.0 pm) 

rn = Total radius (The distance: Focus - Margin) 

G(ro) = First increment size (about 0.8 pm) 

G(rn) = G(rn-,) if G(rn) is not measured. 

The method is based on the assumption that the reader (user) can read a 
portion of the otoliths part, and that there may be a part of the otolith 
where increments cannot be observed. In these parts of the otolith, the 
expected number of rings are calculated from mean increment size of the 
adjacent areas. Since the quality of each reading will vary, the readings 
with the highest quality are given the highest weight in the estimations. 

A sketch of the method is given in Fig. 56. The time of formation of the 
first daily increment will vary from species to species. In anchovy 
(Engraulis rnordax) the first daily increment is formed at the end of the 
yolk sac stage or at an age of 5 days at 16°C (Brothers et a/., 1976). In 
Norwegian spring spawning herring (Clupea harengus), and herring 
generally in northern waters, the first daily increments are expected for 
form at the end of the yolk sac stage, at an age from 10 days at 5°C 
(Messieh et a/., 1987; Moksness et a/., 1987). In cases where growth is 
less that 0.15-0.10 mm/24 h, daily increments are not expected to form. 
This specially concerns the autumn spawning herring. 

If the nucleus and the first increment have been destroyed by grading or 
acid treatment and therefore cannot be read, the following values are set 
for herring (Moksness et a/., 1987): 

51 



ro = 10 pm 

G(r,) = 0.8 pm 

4- X increments- - 3 increments ____) 

Edge o f  Focus R1 R2 Ma r g i  n 

Figure 56 Sketch of calculation method used in the program (from 
Methot, 1981). 

Calculatina da ilv arowth rate 

When age in days and the distance between the increments are calculated, 
the daily growth rate can be back-calculated. 

It is assumed that the daily growth rate in length and weight is reflected 
in the distance between the daily increments. 
the otolith radius and the species' length/weight must first be 
established. An example of such a relationship is given in Fig. 56. 

The relationship between 

Gompertz and von Bertalanffy growth curves describe well the growth in 
herring larvae from hatching up to metamorphose, but von Bertalanffy 
gives a better description, especially at the early stages (Messieh et al., 
1987). The two growth curves, Gompertz and von Bertalanffy, are as 
fol lows: 

Lt = L (b) ct 
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and 

Lt = L, (1 -e-k(t-to)). 

n 

s 
U 

Q c 
Y 

P 
Q 
VI 

E 

'C 

I y = 7.5402 * lO"(O.0439~) R = 1 .OO I 

200 

100 

8 12 16 20 24 28 32 
Length (mm) 

Figure 57 
larvae (Pers. comm. G. Lough, NEFC, Woods Hole, USA). In this example: 
X = (Ln Y)/(0.0439 * Ln 7.5402). 

Ratio of otolith radius and standard length observed in herring 
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Technical desc rbtion . of the eau ipment 

The Macintosh is connected to a HE1 video digitizer through the 
Macintosh's modem port and the video digitizer's RS232 port. 
transmission is done by 9600 Baud, 8 data bit, 1 stop bit and no parity. 
The video digitizer makes a vertical black I ine on the monitor that is 
controlled from the Macintosh through the mouse in the "Session 
control"-window. A sketch of the setup is shown in Fig. 44. 

Data 

Computer: Any computer with an Apple Macintosh operating system. 

Cable: Cable between the Macintosh computer and the digitizer. 
Configuration as the old cable between lmagewriter I I  and Macintosh Plus. 
Apple product A2C0311. 

I Pln-configuration I 

DIN-8 (Macintosh) DB-25 (Diuitizer). 

2 20 
3 3 

5 2 

Figure 58 Wiring schematic for cross-overs in the DIN-8 to 
DB25 cable connecting the Macintosh to the HE1 digitizer. 

Two 75 Ohm Axial cables with BNC plugs for connection between video 
camera, monitor and digitizer 

Monitor: Any high quality black and white or color monitor. 

Camera: Any high quality black and white or video camera. 
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Electronic digitizer: 582A video coordinate digitizer supplied by H.E. inc., 
2601 McLeod Drive, Las Vegas, Nev. 891 21, USA. 

- 582A Video Coordinate Digitizer 
- Option L, LED display of recticle coordinates (can be dropped) 

- Option B, CCIR/50 Hz Compatible Video 
- Option 03, 230 V 50 Hz Power supply 

In countries using 220 V and 50 Hz, in addition: 

Microscope: Any high quality microscope with attachment for a video 
camera. An example is as follows: 

Nikon Optiphot X-A Microscope 
- Nikon Optiphot X-A Microscope stand 
- Trinocular tubes F X/Y 
- Ocular pair CFW 1OX 
- Phase-Condenser X/Y 
- Mechanical Stage R2 
- CF-E plan 6.4 X 
- CF-E plan 10 X DL 
- CF-E plan 20 X DL 
- CF-E plan 40 X DL 
- CF-E plan 100 X DL-oil 
- Illumination 12V 50W Halogen 
- Polarization filters 

Oil to use at magnification 100 X: Immersion oil for microscope, Nikon 50 
Type A. 

Sand paper: Imperial lapping film of 30 pm, 12 pm and 0.3 pm made by 3M 
company. 
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a 

Blackt’White monitor Microscope 

Figure 59 Sketch of equipment set up. 
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